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How to reach us:
You can e-mail us on the Internet at ddeloach@msn.com for "same
or next day" service (we check our mail every day).

For technical support by phone, call Darren evenings from 7:30 pm to
10:30 pm Central at 903-583-0982.

You can always find the latest program updates on our World Wide
Web site at http://www.deloach.com.
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Welcome to DSSTest, the fast track to passing your next FAA
Knowledge Exam!  Using DSSTest, you can create
individualized Study sessions to reinforce your knowledge,

then test yourself with randomly selected Test sessions to verify you
are ready for the real thing.  Using our software, you'll gain confidence
in your ability to pass the written exam and take the next step in your
flight training.

With DSSTest you will first use Study Sessions to drill yourself on the
subject knowledge in each of the question topic sections.  Then you’ll
do a number of Test Sessions to gain confidence in your knowledge of
the subject material.  Once you have passing scores on every Test
Session you take, you'll know you are really ready for the final exam,
and you are assured of passing!

Each time you do a Study or Test Session, your results are saved in a
history file that you can view or print at any time.  You should see
steady improvement as you use the software; the history data will let
you monitor your progress.  Early in your studies, you will only be
working with Study Sessions.  As you progress, you should do more
and more Test Sessions.  When you can pass every Test Session with
solid scores you can feel confident in your ability to pass the real test.

One important element of this software is the ability to view the
diagrams and charts required to answer the questions on your screen;
you won't have to waste time looking up the figures in your study
guides.  I am sure you'll agree this is a valuable component in using
software-based study methods!

Optionally included in this version of DSSTest is our DSSCalc Flight
Computer software.  In addition to making your exam studies quick
and easy, you’ll also run it stand-alone for fast and accurate preflight
computations!

This manual will give you all the information you need to get started
studying for your upcoming FAA Knowledge Exam.  After installing
the software, you’ll find more information in the on-line Help. Be sure
to read through the Help file at least once, to get a feel for how
everything fits together.  You can always bring the Help file back up at
any time using the “Help” menu on the main menu line of the program.

Section I

Overview
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Before Running Setup
Before you install DSSTest, make sure your computer meets
the following minimum PC requirements:

System Requirements

• An IBM PC-compatible, running Microsoft Windows 95,
or Windows 3.1 or Windows for Workgroups 3.11
operating system in 386 Enhanced Mode

• 4 Megabytes of total RAM memory (or more)

• 6 Megabytes of free hard disk drive space (10 Meg for the
Instrument Exam Database); 1.5 additional Megs are used
during installation for temporary files.

• VGA Card and monitor (or better); 256 Color mode (or
better) required to view some of the FAA diagrams
(particularly the NOS Sectional Chart excerpts).  DSSTest
works in any screen resolution 640x480 or higher.

We welcome any comments you have on the installation and
use of our software; future enhancements (and future pilots)
depend on your feedback.

README.WRI File
IMPORTANT!   There is a README.WRI  file on Disk 1 in
Microsoft Write format with special information about this
release. This file contains a section on solutions to installation
difficulties in addition to other information, so if you have any
problems while installing use Windows Write (or WordPad for
Windows 95 users) from the Accessories Group to read the
file directly from the floppy disk.

Setting Up DSSTest
1. You should already be in Microsoft Windows.  CLOSE
DOWN ALL OTHER APPLICATIONS  to avoid conflicts
during installation.

Program Installation
Section II
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2. Place Disk 1 in the appropriate 3.5” floppy disk drive, then:
• Windows 3.1/3.11: From Program Manager,  select the

“File”  menu option, then select the “Run” option.

• Windows 95: Click the “Start”  button then choose
“Run”

• All users: On the "Command Line" field, type
“A:SETUP”  (substitute the correct floppy drive letter for
"A:" if needed).

3. The Setup program will initially copy several startup files to
your hard disk.  Windows 95 users note: Just after you start
the installation, a message box warning of being unable to copy
file DDEML.DL_  because it is already in use may display on
your screen.  Click on the OK button and continue installing—
the message is informational only, and is NOT A PROBLEM
for a Windows 95 installation.

4. The drive selection dialog is displayed.  You must type in the
drive and path to which you want to install the software.  The
default is "C:\DSSTEST", but you may type in any drive letter
and path you desire.  Click on the "Continue" button.

5. The program will copy a number of files to your chosen
drive and path as well as several files to your Windows System
directory (see the list below for the affected files).  You will be
prompted for each disk in turn, one after the other, in order.

6. After you have fed in all disks, there will be a long pause as
the program constructs the exam database.  Next, the program
will create a new Program Group called “DSSTest”  with two
icons, one for the DSSTest program and one for the On-Line
Help. Two additional icons will also be added for the DSSCalc
Flight Computer if included with the package.

7. IMPORTANT! For Windows 3.1 users only [NOT
Windows 95 or Windows 3.11 for Workgroups]. One final
check is performed on your system before the install program
exits.  The database engine used in our software requires that
you have either the DOS program “SHARE” or the Windows
program “VSHARE.386” loaded in order to run.  If VSHARE
is NOT detected, a dialog will display informing you of this and
if possible, will offer to automatically add VSHARE.386 to your
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Windows SYSTEM.INI file. If you answer “Yes”, a backup
SYSTEM.OLD file is created, and the following entry is
written  into the [386Enh] section; you’ll have to reboot your
computer for the change to take effect:

[386Enh]
device=VSHARE.386

You may manually add the entry if desired. The VSHARE.386
solution only works if you are running Windows in 386
Enhanced mode (this is true if you have at least a 386
processor and at least 2 Meg of RAM).  If you are unable to
use VSHARE.386, you may instead use the DOS SHARE
command.  This is the least recommended solution, and
should only be used if you absolutely cannot run VSHARE.386.
To use SHARE instead, in your AUTOEXEC.BAT file, place a
line which reads:

SHARE /L:500

and reboot your PC.

8. Be sure you read the on-line documentation when you’re
first trying out the software for specific details about each
dialog.

Files Installed By DSSTest

In the installation directory:

• DSSTEST.EXE, DSSTEST.HLP — the DSSTest
program and on-line Help files

• DSSCALC.EXE, DSSCALC.HLP — DSSCalc program
and on-line Help files (optional)

• DSSUSER.MDB — user options database

• DSS??.MDB — FAA Exam databases

• *.LDB  — Small files created and used by the database
engine; you may delete these if necessary, they will be
recreated the next time you run the program.

In your Windows directory:

• DSSAV8N.INI — INI file used by all DS&S applications.
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In your Windows System directory:

• CMDIALOG.VBX, MSOUTLIN.VBX,
THREED.VBX, KNIFE.VBX, PICBTN1.VBX,
MSAES110.DLL, MSAJT110.DLL, VBDB300.DLL,
VBRUN300.DLL, IMK.DLL — shared tools and DLLS;
other applications you own may also use some of these files.

• VSHARE.386 — Windows substitute for the DOS SHARE
program; works Windows 386 enhanced mode only.

No modifications are made to any of your boot or Windows
configuration files (except for adding VSHARE.386 to
SYSTEM.INI in some Windows 3.1 cases).

Network Installation Issues
The license allows for network installation (see the on-line help
file).  In a “shared” Windows setup, you may have a problem
copying setup files to the shared directory unless you have rights
to create and write files in the shared Windows directory.  The
installation program will report the possibility, you can attempt to
continue the install or get the help of your System Administrator.
Note that files listed above as going to your Windows System
directory are instead installed into your local Windows directory,
which may conflict with older versions of the VBX or DLL files
located in the shared Windows directory.

Installing and Using Multiple Exam Databases
You can use DSSTest with more than one Exam database.
Install all exams into the DSSTest program directory. To change
databases:

1. Select the “File” then “Open” menu option.

2. The Open File common dialog is displayed. Locate the desired
database.  All DSSTest databases are named "DSS" followed by
two letters, with an extension of ".MDB".

3. Choose the OK button to open the new file, or the Cancel
button to abort the operation and return to the old file.

Note: Whenever you start the program, it will automatically
open the most recently used database.
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Running the Program the First Time
The first time you start up the program, there are a few things
you need to do before you begin your studies. These options
represent items which will rarely need changing after you have
set them up.

Personal Information Dialog
This information is used only to print out Sign-off letters for
your instructor to sign to allow you to take the exam.

1. Select the “Options”  menu option on the top menu line.

2. Select the “User Info”  option on the Options pop-up menu.

3. The User Information dialog is displayed (see figure
below).

4. Choose the “OK”  button to save your data, or the “Cancel”
button to abort the operation.

Here's a diagram of the User Information dialog:

Section III
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Question References Dialog
When you answer a question incorrectly, the software will give
you references to look up to get more information about the
question topic.  This dialog allows you to select which
references are given (if any).  To get to the Question
References Dialog:

1. Select the “Options”  menu option on the top menu line.

2. Select the “References” option on the Options pop-up
menu.

3. The References dialog is displayed (see figure below).

4. Click on the checkbox for each reference you want
displayed.

5. Choose the “OK”  button to save your choices, or the
“Cancel” button to abort the operation.

Here's a diagram of the References dialog:



10

Creating Study and Test Sessions

Creating a Study Session
Before you test your knowledge in Test Sessions, you'll first
drill the exam questions in Study Sessions.  You can select
specific areas of knowledge to study each session, so that you
can work on the areas which need the most study.  To create
a Study Session:

1. Select the “Study”  menu option on the top menu line.

2. Select the “New Session” option on the Study pop-up
menu.

3. The Study Session dialog is displayed (see figure below).

4. Choose the “Begin”  button to begin your study, or the
"Cancel" button to abort the operation.  Go to Section V,
“Using the Session Screen Controls” for information on how to
complete your Study Session.

Here's a diagram of the Study Session dialog:

Section IV
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The Question Selection Frame

The five radio buttons in the “Select Questions From” frame
allow you to select the questions used in your study session from
one of five possibilities.  After each available option, a number in
parentheses lets you know how many questions are represented
by the given selection.  The possible choices are:

a. Specific Sections: Use the Study Topic Outline Window to
select specific chapters or subchapters.

b. Questions Missed Last Study Session: Selects only those
questions you missed on your first answer attempt during the
most recent Study Session.

c. Questions Missed Last Test Session: Selects only those
questions you missed on your first answer attempt during the
most recent Test Session.

d. All Questions Ever Missed: Selects all of the questions
you have ever missed in ANY study or test session.  Remember
that this option will be affected by the Purge History menu option
since purging also deletes the list of missed questions.

e. All Sections: Selects all of the questions in the database.

The Study Topic Outline

Using the Topic Outline, you can target your Study Session for
one or more specific areas of study.  The Outline mirrors the
Jeppesen Study Guide for the particular test you are working on.
Using the Outline, you can select whole chapters from the Study
Guide or specific subchapters—  you can even mix-and-match
subchapters from different chapters!  There are four basic
operations you can do with the Outline:

a. “Open”  a chapter to view the subchapters beneath it in the
outline.  With a mouse: click on the “+”  symbol on the left side
of the chapter heading.  With the keyboard: highlight the chapter
text using the arrow keys, then press the “plus” (+) key.

b. “Close” a chapter to hide the subchapters beneath it in the
outline.  With a mouse: click on the “-”  symbol on the left side of
the chapter heading.  With the keyboard: highlight the chapter
text using the arrow keys, then press the “minus” (-) key.
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c. Select a whole chapter or a subchapter to study.  With a
mouse: click on the text of the chapter or subchapter.  A small
airplane symbol appears, marking selected sections.  This is a
toggle; click again to “deselect” a section.  With the keyboard:
highlight the section text using the arrow keys, then press the
spacebar.  This is a toggle; press spacebar again to “deselect” a
section.

At the Chapter level of the outline, a blue airplane represents a
chapter with ALL of its sections selected, while a purple
airplane denotes a chapter which has one or more sections
unselected (i.e. the chapter is partially rather than completely
selected).

d. Scroll the Outline, using the Topic Outline Scrollbar.

Creating a Test Session
After you have mastered the material contained in the study
sessions, you are ready to try sample tests to confirm your
knowledge.  The tests are constructed from the question base;
selection is “semi-random”, in that within a subject area
questions are chosen randomly, but all subject areas are covered
(just like the real FAA exams).  To create a Test  Session:

1. Select the “Test”  menu option on the top menu line.

2. Select the “New Session” option on the Test pop-up menu.

3. The Test Session dialog is displayed (see figure below).

4. Choose the “Begin”  button to begin your test, or the
"Cancel" button to abort the operation.  Go to Section V, “Using
the Session Screen Controls” for information on how to complete
your Test Session.

Here is a diagram
of the Test
Session dialog:
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Using the Session Screen Controls
Section V

This is a sample screen you might see during a Study or Test
Session.  This diagram shows every possible screen control; on
any particular question, not all of these items will be displayed.
The screen is divided into two basic sections.  On the left side is
the Picture Window and its associated controls, and on the right
side you see the Question & Answers and Navigation buttons.

The Picture Window
Figures and legends are displayed in the picture window.  In
addition to using the Picture Window Horizontal  and Vertical
Scroll bars to “pan” the picture and the Max-Min Button (the
button with two arrows pointing up and down) to change the size
of the viewing area, you can also:

a. “Zoom” IN  on a picture without panning:  With a mouse:
click once with the left mouse button anywhere on the figure, or
click the "+" button below the picture. With the keyboard: press
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the "+" key, or select the "+" button with the tab key the press
the button with your spacebar.

b. “Zoom” OUT  on a picture without panning: With a mouse:
double-click with the left mouse button anywhere on the figure,
or click the "-" button below the picture. With the keyboard:
press the "-" key, or select the "-" button with the tab key the
press the button with your spacebar.

c. “Zoom” IN  on a picture with panning to select a specific
area: With a mouse: click once with the left mouse button at the
top left corner of the area you want to select, then drag your
mouse downwards; a selection box will appear to show you the
selected area.  Release the mouse button to select the area, or
drag the mouse upwards above the corner you initially selected
to cancel the zoom operation. With the keyboard: no keyboard
interface for this!

d. Reset the picture to fill the window horizontally: With a
mouse: click once with the right mouse button anywhere on
the figure. With the keyboard: no keyboard interface for this!

All pictures initially start out zoomed so that the entire figure fits
into the window; therefore most pictures will require you to zoom
in on the figure to view any details of the picture.  The "Max-
Min" button enlarges the picture window to fill the screen for
easier viewing of larger diagrams (right-click the picture after
selecting this button to make the picture fill the window).
Questions which have more than one figure associated with
them will also have an "Alternate Figure" button to swap
between the various figures in the picture window.

The Question Window
Located in the upper right corner, this window displays the text
of the FAA exam question.  Most questions are short enough
that the entire text of the question will fit in the window.  Some
longer questions, however, will require you to use the vertical
scroll-bar to scroll the window text and view the undisplayed
portion of the question.  The text embedded in the frame at the
top of the question gives you the current session question number
in brackets (1 through the number of questions in this session),
and the FAA Question Number (for example, the Private Pilot
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questions are numbered beginning with 3001, Instrument Pilot
with 5001, etc.).

The Answer Buttons
Located just below the Question Window are three answer
buttons, “A” through “C”.  Click one of these three buttons to
select your answer (or press the “A”, “B” or “C” key on your
keyboard). If your answer is correct, the next question will be
displayed; otherwise, the “Wrong Answer” window will pop up.
Once you have answered a question, the answer button you
have chosen will be colored cyan anytime that question is
subsequently displayed during the session.

The Navigation Buttons
Just below the three Answer buttons are the Question
Navigation buttons, “Next” (next question), “Prev” (previous
question), “>>Blank” (next unanswered question), “Mark” (place
a “bookmark” on this question), “>>Marked” (jump to next
bookmarked question), and “End Session” (end this session).

Note that you can simply press the underlined letter (the Alt key
is NOT required) to select the corresponding button as well; for
example, just press “N” for Next, “P” for Prev, etc. Of course,
as with all Windows programs you can always tab to a button
then press the spacebar to "click" it.

During your Session, first read the question, then click on one of
the Answer buttons (A, B or C).  You are not required to
answer a question; you can skip it and come back later.  The
"Next" and "Previous" buttons let you navigate through the list of
questions selected for the Study or Test Session.  The ">>Blank"
button will jump to the next unanswered question.  Use the
"Mark" and ">>Marked" buttons to place a "bookmark" on a
question, and jump around among the bookmarked questions; this
is especially useful when you want to skip a question for now
and come back to it later.  When you have answered all the
questions (or as many as you plan on answering) you simply
press the "End Session" button to stop the session and grade it.
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Reviewing and Printing Your Results

Section VI

Viewing the results of your most recent Study
Session

You can view a detailed description of your most recent Study
session as follows:

1. Select the “Study” menu option on the top menu line.

2. Select the “Previous Grade”" option on the Study pop-up
menu.

3. The Previous Study Session dialog is displayed.

4. Choose the OK button to close the dialog.

Viewing the results of your most recent Test
Session

You can view a detailed description of your most recent Test
session as follows:

1. Select the “Test” menu option on the top menu line.

2. Select the “Previous Grade” option on the Test pop-up menu.

3. The Previous Test Session dialog is displayed.

4. Choose the OK button to close the dialog.

Viewing a history list of all Sessions

You can view a list of all of your study and test sessions with
their results as follows:

1. Select the “History” menu option on the top menu line.

2. Select the “Display” option on the History pop-up menu.

3. The Session History dialog is displayed.

4. If a vertical scrollbar is visible, you may use it to scroll the list
to review all of the sessions.  You can drag the scroll thumb,
click anywhere within the scrollbar, or click on the arrows at
either end of the scrollbar to scroll the list.

5. Choose the "Print" button to print a copy of your history, if
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desired.

6. Choose the OK button to close the dialog.

Printing a history list of all Sessions

You can initiate printing of your session history either by:
1. Choose the “Print” button on the Session History dialog.

- OR-

2. Select the “File” menu option on the top menu line.

3. Select the “Print History” option on the File pop-up menu.

- THEN -

4. The Printer Setup common dialog is displayed.  Select the
desired printer and settings.

5. Press the OK button to print the history, or press the Cancel
button to abort the process.

Purging (Deleting) the history list of all Sessions

You can delete your entire session history list as follows.
WARNING: Once your history is purged, it can never be
recovered (though new sessions will build a new history)!

1. Select the “History” menu option on the top menu line.

2. Select the “Purge” option on the History pop-up menu.

3. You will be prompted to verify you really want to purge your
history.  Choose the “Yes” button to purge, or the “No” button to
abort the purge.

Printing a Sign-Off Form

Many FAA Exams require approval of your CFI or CGI in order
to be allowed to take the exam, for example the Private Pilot and
Instrument Pilot exams.  When you are ready to take the exam,
you must print a sign-off form, have your instructor sign it, and
take it with you to your chosen examination site.  The Sign-off
Form uses information you have entered in the User Information
dialog (such as name, address, SSN, etc.).

To print a sign-off form:
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1. Be sure you have entered your personal data on the User
Information dialog:

a. Select the “Options” menu option on the top menu line.

b. Select the “User Info” option to get the User Information
dialog.

c. Enter your personal data on the dialog, and press the OK
button to save it.

2. Select the “File” menu option on the top menu line.

3. Select the “Print Sign-Off” option on the File pop-up menu.

4. If no sign-off is required for your chosen database, a message
box will inform you of this.  No further action is required.

5. The Printer Setup common dialog is displayed.  Select the
desired printer and settings.

6. Press the OK button to print the form, or press the Cancel
button to abort the process.

7. Once you have printed your form, be sure your instructor
signs it before you go to your chosen examination site!
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Section VII

DSSCalc Flight Computer

Welcome to DSSCalc, the fast and easy way to do everyday
aviation computations! Using DSSCalc, you can quickly
perform all of the usual preflight calculations on your own

computer.  If you are using DSSTest, our FAA Written Exam software
for Windows, you'll like how easily you can work on study sessions with
a real flight computer only a mouse click away!

DSSCalc works like a standard electronic flight computer.  If you
already own a Jeppesen Techstar electronic flight computer, you'll feel
right at home with DSSCalc!

DSSCalc is actually two calculators in one: a standard "four-banger"
calculator with +. -. *, / and % operators, and a menu-driven aviation
computer with numerous aviation computations and conversions built-
in.

You’ll find more information about DSSCalc in the on-line Help. Be
sure to read through the Help file at least once, to get a feel for how
eveevverything fits together.  You can always bring the Help file back
up at any time using the “Help” menu on the main menu line of the
program.

Starting DSSCalc
You can bring up DSSCalc in two different ways:

1. Click on the “DSSCalc” menu option on the top menu line of the
DSSTest program.

2. You can also run it standalone.  The installation program created an
icon for DSSCalc in your DSSTest group when you ran the Setup
program.  Use DSSCalc for fast and accurate preflight computations!
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The DSSCalc Program Window
The main program window consists of three areas: the menu at
the top of the window, the aviation menu/computation menu
buttons in the middle, and the calculator keys at the bottom:

There are only four Menu options required in DSSCalc:

• Exit — Quits out of the
program.

• Clear — Clears all input and
computed data from the aviation
computation section (same as
double-clicking the “C” Clear
button).

• Print  — Prints the current
aviation computation to your
default Windows printer.

• Help — Displays the On-line
Help program documentation.

The Aviation Computation
menu  has nine buttons arranged
vertically on the left side, and
each button has an associated
input/computed value window on
the right side.  These buttons
represent a “menu” to guide you

through your computations; clicking a button will either select the
described sub-menu, or copy the value in the calculator display
(the yellow box) into the described problem input.

The Calculator keys are at the bottom, and work just like a
regular hand-held calculator.  Note that four conversion buttons
along the top give you instant access to mileage and temperature
conversions without going through the aviation menus.  The
“Store”  and “Recall”  buttons work on the ten independent
memories numbered “0” through “9”; you can save numbers or
time values.  The “Menu”  button is special: it will reset the
Aviation Computation menu to the startup “main” menu where
you can select the type of aviation problem you want to solve.
Finally, the “:”  button lets you enter time values in standard
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“hh:mm:ss” format.

In actual practice, to perform aviation calculations you will:

• Click the Aviation Menu buttons to get to the correct
problem entry screen.

• Enter numbers and times in the yellow calculator display,
then click the menu button corresponding to the number you
typed to enter the value into the aviation problem.

• Read the answers from the aviation menu. Computed values
are displayed in blue, while your inputs are in black.

Keyboard Interface
You should also note that in addition to the obvious buttons
which you can click with your mouse, there is also a keyboard
interface for the calculator as well. Every button in the lower
part of the screen has a key associated with it, and though there
is no direct keystroke for the Menu buttons, you can still select
them with the Tab key and "press" them using the spacebar.  Of
course, as with all Windows programs you can always tab to any
button then press the spacebar to "click" it.

The number buttons use the associated number key as you
would expect.  The operator keys are "+", "-", "*" or "X" for
multiplication, "/" for division, "%" and "=".  "M" gets you the
Main Menu, "S" and "R" do the Store and Recall Memory
actions, "C" is the Clear key and "E" is the Clear Entry key,  ":"
or ";" is for time entry, the backspace key backspaces as you
type, and the "Q" key quits the program.

Sample Problems
The On-line Help has a complete Sample Problems topic which
walks you through each kind of aviation problem. Each problem
gives you keystroke-by-keystroke instructions to perform each
problem type. Be sure to work through each type of problem at
least once, so that you get a good feel for how it all fits together!
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Taking the Real Exam

Section VIII

First, for many FAA tests (such as the Private Pilot and
Instrument Pilot) you must have authorization from your
instructor to take the exam; this software can print a standard
Sign-off Form to have your instructor sign.

If you have successfully completed a number of sample Test
Sessions, you can be confident you will pass your exam: you
have been working with the real questions from the FAA
Written Test groups, your actual exam will be no different than
what you have already studied.

There are several tools which are required for many exams, all
of which you can purchase directly from your local dealer or
directly from us at DeLoach Sales & Software; see the next
page for more information.

What you should take to your exam:

1. A flight computer, either manual (CSG/E6B) or electronic
(such as the Jeppesen Techstar).

2. A pocket calculator (not necessary if you have an electronic
flight computer, as these also do standard computations as
well).

3. Extra batteries for calculators (Murphy's Law applies
here!).

4. A navigation plotter (Jeppesen PN-1 or equivalent).

5. Your sign-off form.

6. Picture identification of yourself with a signature and your
actual residential address (drivers license, etc.).

Pencils and scrap paper are supplied at the examination site.
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Tools for Successful Exams

JEPPESEN TECHSTAR

No other handheld flight computer gives you this much capability! The
Techstar features a menu-driven data entry screen, with easy-to-follow
prompts for all required inputs.  It comes in a small box with the unit, 4
AAA batteries, instructions and a small plastic cover.   Features:

• Over 25 Aviation Calculations

• 55 Conversions (such as  °F to °C, Statute Miles to Nautical Miles, etc.)

• 6 Independent Memories to save interim results

• Enter Values In Any Order— Change
Them At Any Time!

• Easy-To-Use Menus Guide Your
Inputs To Each Problem
Weight And Balance ANY NUMBER
of Items, Including Weight Shifts

• 5 Operating Modes: Time-Speed-
Distance-Fuel,  Altitude-Airspeed, Wind
(heading, crosswinds, etc.),  Weight and
Balance,  Timer (counts up or down).

• Three Year Warranty

• Approved For Use on FAA Written Exams!

Section IX

You can purchase these items and more at your local pilot shop or
directly from DeLoach Sales & Software.

Jeppesen Flight Computers: Both Student and Metal Manual CSG
Flight Computers - Jeppesen's version of the venerable E6B, features
a circular computer on one side and a sliding wind computer on the other.

Jeppsen Plotters: PN-1 - Classic navigation plotter, WAC and
Sectional scales in statute and nautical miles. PJ-1 - Rotating azimuth
plotter.  True and magnetic courses are measured by simply rotating the
azimuth dial instead of moving the whole plotter.  Folding - Folds down
to pocket size!  All the features of a standard plotter (unfolds to 15
inches).  Scales for  WACs, Sectionals and TCA charts; measures in
statute and nautical miles and kilometers.



Legal Copyright and Software License
This software and program documentation are Copyright © 1996
DeLoach Sales and Software.  This software is a commercial product,
and is NOT shareware, freeware, or public domain software.

No-Nonsense License

This software is covered by United States and international copyright
laws.  You must treat this software like a book, except that the software
is licensed only to a single individual.  You MAY install the software on
more than one computer, so long as ONLY the individual user to whom
the software is licensed uses the software.

Just as a single book cannot be read by two different persons in two
locations at the same time, neither can this software be used by two
different people simultaneously (either on a network of computers or by
making more than one copy of the software), or in fact by anyone other
than the individual user to whom the software is licensed, or you will be
in violation of this license and copyright laws.  You MAY make backup
copies of the software for archival purposes only, but not to give away
or sell to other users.

We aren't trying to place any undue restrictions on your usage of our
software, but we expect you to be honest and not cheat our company
(and my family)  by making illegal copies of the software for your
friends.  We are an honest business, we charge a fair price for good
software, we have in every way possible tried to be up-front with our
customers, and we expect the same treatment in return.

If any of these License terms are objectionable to you, you may return
the software for a full refund.
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